
Ulead COOL 3D 1.0, 2.x Support 
COOL 3D 2.0 Update Patch 
Ulead COOL 3D 2.0 Update Patch (for all language versions)  

Problems solved by this Ulead COOL 3D 2.0 patch: 

1. Rendering problems with the "Times New Roman" font - some letters (for example, the 

letter k) cannot be rendered completely.  

2. The "Exception 10H" error for the video codec and printer driver.  

Ulead COOL 3D 2.0 update patch  
For all language versions (1705KB) 

site 1 site 2 

 
To install this patch, simply download and run the .exe file from one of these sites.  

 

Ulead COOL 3D 2.0 for NT4 SP4 or above Installation Patch 

Problem solved by this patch: The Ulead COOL 3D 2.0 CD-ROM version can't be installed on 

NT4 SP4 or above.  

If you're a download version user, please contact the original online purchase site to download 

the updated version.  

For Ulead COOL 3D 2.0 FULL version  

Ulead COOL 3D 2.0 for NT4 SP4 or above installation patch  

English  
(1214 KB) 

German 
(2621 KB) 

French 
(2626 KB) 

Japanese 
(2603 KB) 

Chinese 
(2600 KB) 

site 1 site 1 site 1 site 1 Site 1 
site 2 site 2 site 2 site 2 Site 2 

How to install this patch: 

1. Insert your Ulead COOL 3D 2.0 CD into the CD-ROM device. 

2. Run the appropriate .exe file for your language version: 

 

C3D2_E_P.exe for English Full version CD 

C3D2_G_P.exe for German Full version CD  

C3D2_F_P.exe for French Full version CD 

ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/C3D20_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/C3D20_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/English/C3D2_E_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/German/C3D2_G_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/French/C3D2_F_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/Japanese/C3D2_J_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/Chinese_T/C3D2_TC_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/English/C3D2_E_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/German/C3D2_G_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/French/C3D2_F_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/Japanese/C3D2_J_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/Chinese_T/C3D2_TC_P.exe


C3D2_J_P.exe for Japanese Full version CD 

C3D2_TC_P.exe for Chinese Full version CD  

For Ulead COOL 3D 2.0 Upgrade Version  

Ulead COOL 3D 2.0 for NT4 SP4 or above Installation Patch  

English  
(1214KB) 

German 
(2621KB) 

French 
(262 KB) 

Japanese 
(2603KB) 

Chinese 
(2600KB) 

site 1 site 1 site 1 site 1 Site 1 
site 2 site 2 site 2 site 2 Site 2 

How to Install this Patch: 

1. Insert your Ulead COOL 3D 2.0 CD into the CD-ROM device.  

2. Run the appropriate .exe file for your language version: 

 

C3D2E_UGD_P.exe for English Upgrade version CD 

C3D2G_UGD_P.exe for German Upgrade version CD  

C3D2F_UGD_P.exe for French Upgrade version CD 

C3D2J_UGD_P.exe for Japanese Upgrade version CD  

C3D2TC_UGD_P.exe for Chinese Upgrade version CD  

COOL 3D 2.0, 2.5 Manual 
You can choose the manual language version you need after you access one of the sites below. 

Click a site to download the manual. 

 
2.0 2.5 

site 1 site 1 
site 2 site 2 
site 3 site 3 

 
 

Ulead COOL 3D 1.0, 2.0, 2.5 FAQs 
Error messages 
Q1: When I load Ulead COOL 3D 2.0, a warning message "Component manager error. Class 

not registered. Unable to insert all plugins" comes up. What does this message mean? 

Answer: This warning message indicates a problem with the registration of the file comcat.dll. 

To correct the problem, follow the steps below: 

1. Rename comcat.dll as rcomcat.dll or any other name  

ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/English/C3D2E_UGD_P.exe
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ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/Japanese/C3D2J_UGD_P.exe
ftp://ftp.ulead.com/pub/Updates/Cool3D2.0/Chinese_T/C3D2TC_UGD_P.exe
ftp://ftp3.ulead.com/pub/Updates/Cool3D2.0/English/C3D2E_UGD_P.exe
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2. Download this file: "ccdist.exe"  

3. Go to MS-DOS Prompt (Click Start/Programs/MS-DOS Prompt)  

4. Change your drive and directory to the Windows /System/subdirectory (i.e. 

C:\Windows\System)  

5. Type the following command in the prompt "regsvr32 comcat.dll"  

6. Reboot  

Q2: Why can’t I create a file in the image or video format? Each time I try doing that, an error 

message: “Failed to Allocate Memory, use lower resolution...” appears. 

Answer: According to our past experience, problems such as these are mostly caused by your 

VGA card interaction with DirectX, we suggest that you go to the Control Panel, access the 

System dialog box and click the Graphics button. Move the acceleration slider to one notch 

above None and then reboot.   

 
Q3: I receive a “runtime error, abnormal termination error…” when trying to access almost half 

the effects. All I have to do is click on the main folder of the certain type effect and the program 

quits. What can I do to fix it?  

Answer: The problem is caused by your Windows System being unstable. We suggest that you 

install it in on another computer and check if the problem persists or not. And if there is no 

problem in the other computer, you should re-install your Windows system.   

 
Q4: When I run COOL 3D, I receive the following message: " U3DEDIT caused an invalid page 

fault in module KERNEL32.DLL ". What is causing this? 

Answer:  
Please try the following:  

1.Delete U3DEDIT2.ini (just do it one time)  

2.Update the Direct X driver to version 8. You can download the free update  

from Microsoft's web site. http://www.microsoft.com/directx/download.asp  

3.Update your VGA driver  

If you don't know what kind of VGA card you are using, you may check this information by 

clicking Start/Setting/Control Panel/Display  

==>Settings/Advanced/Adapter and then contact the manufacturer or visit their web site to get 

the driver.  

4.Change your settings:  

Start/Settings/Control Panel/System/Performance/  

Graphics: Hardware acceleration---set to “None” and then reboot. 

 

ftp://ftp.ulead.com/Silent/Ccdist.exe


Installation questions 
Q1a: I have the full version of Ulead COOL 3D 2.0. When installing the Ulead COOL 3D 2.5 

Trial version, a warning message says: "Installation Program has detected that Ulead COOL 3D 

2.0 is already installed in your system. Do you want to overwrite? Clicking Yes will overwrite all 

presets created in the EasyPalette. To avoid this, Press No to Abort."  

 

Q1b: I've saved many of my own customized presets. How do I save them? 

Answer: We suggest you backup both the "Presets" and "Plugins" folder under D:\Program 

Files\Ulead Systems\Ulead COOL 3D 2.0, then install the COOL 3D 2.5 trial version. When you 

reinstall COOL 3D 2.0, you may use your backup files to restore the original ones.  

Or you may export presets from COOL 3D 2.0 to .uez files. To find out more about exporting 

to .uez files, please read Q19.  

 

Q2: I am testing the application Cool 3D 2.5 against the Windows 2000 OS. Will it work? Is it 

supported and is there a compatible version?  

Answer: Sorry but we can't guarantee that Ulead COOL 3D 2.5 can work on Win 2000 with no 

problems because Win 2000 was released later than Ulead COOL 3D 2.5. We suggest that you 

upgrade to the latest version of Ulead COOL 3D. Please get relevant info from link below:  

http://www.ulead.com/cool3d/upgrade.htm 

 

Q3: When I am installing the Ulead COOL 3D 2.5, a warning message "A Required .DLL file, 

VBOXP403.DLL, was not found." pops-up after awhile. What should I do to fix this? 

Answer: A likely reason for this message is that your system has been infected with the 

W95.cih virus. This virus will disable the Vbox function of any execution files built by the Vbox 

Builder. You may see messages such as "VBOXP403, VBOXT403, VBOXB403, or .lic file is not 

found" after installation if your system is infected with this virus. Please try scanning your 

system for viruses and delete any that you find. 

 
Q4: I just tried installing COOL 3D 2.0 under Windows NT4, but unfortunately it seems that I 

can’t get a successful installation. What do I need to do to fix it?   
Answer: 
Method A: 

If your COOL 3D 2.0 is a bundled version, please use following steps to install COOL 3D 2.0 on 

NT4 with SP4 or above version:  

1. Create a new folder "C3D20".  

2. Click the attached file "files.exe" to unzip it, then you'll have two files: Copying files.JPG and 

setup.ins  

3. Open the file named "Copying files.JPG", and copy the request folders and files from your 

http://www.ulead.com/cool3d/upgrade.htm


CD-ROM to C3D20 folder.  

4. Copy a setup.ins file to the C3D20 folder to replace old one.  

5. Click setup.exe file which in C3D20 folder to install COOL 3D 2.0.   

Method B: 

If your COOL 3D 2.0 is a full or upgrade version, then please download the following patch to fix 

it. 

For COOL 3D 2.0 Full version: 

Please download COOL 3D 2.0 Full Installation Patch.  

For COOL 3D 2.0 Upgrade version: 

Please download COOL 3D 2.0 Upgrade Installation Patch. 

 
Q5: When I tried to uninstall the program, I received a message, "Uninstall shield did not install 

properly".  How do I uninstall COOL 3D completely? 

Answer: Apparently it’s because some program files were probably lost, please install COOL 

3D again in the same location to complete the installation then uninstall it using Control Panel: 

Add/Remove programs. 

 
Q6: What display resolution does COOL 3D support? 

Answer: Ulead COOL 3D requires a display settings of High Color(16-bit) or higher for better 

qualities.  

Please take following procedures to adjust your display setting:  

1. Open Control Panel: Display.  

2. Click on tab "Settings" and select "High Color (16-bit)" from the drop-down list of Color 

Palette.  

3. Click OK to apply the setting. 

 
Usage questions  
Q1: After creating a title in Ulead COOL 3D, I can only save my work in .C3D format. No other 

file formats are available under the File:Save/Save As dialog boxes. 

Answer: The File:Save/Save As command saves the active Ulead COOL 3D title for future 

editing. To save the title as an image file based upon the current Ulead COOL 3D title's 

appearance and Image:Output Quality setting, click Image:Save As. A submenu will open with 

the following file format options: BMP File, GIF File, JPEG File, TGA File, GIF Animation File, 

and Video File. 

 
Q2: How can I change the resolution of a Ulead COOL 3D image? 

Answer: To change the resolution of a Ulead COOL 3D image, first create the title as an image 

file by clicking File:Create Image Files and select the file format to use (TGA or BMP is best). 



Then open the file in an image editing program that allows you to change the resolution. 

Remember that changing the resolution affects the image's dimensions when printed. If you 

intend to increase the resolution, (for example, from 96 dpi to 300 dpi), then the original saved 

title should be about three times bigger than the final desired dimensions. 

 

Q3: When I insert an Arabic text , The text didn`t be appear properly. Please tell me how I can 

solve it. 

Answer:  
Ulead COOL 3D doesn't support Arabic.  

However, you may try the following method to do it, this method is coming from one of our 

enthusiastic users:  

"I found good way to type and use Arabic fonts so anybody can use them. I used corel depth 

and I typed in Arabic and export it to (wmf file), then I used COOL 3D function (import graphics), 

then imported my Arabic wmf and it works."   

 

Q4: I create an animation project in COOL 3D and save it as an avi file. It took me 45 minutes to 

do that, but it was only one of your presets. I made no changes to it, just tried to save it. Why? 

Answer: The creation time of an .avi file depends on how many frames and plugins you use, if 

you apply a lot of effects and plugins, then the creation speed will slow.   

 

[COOL 3D 1.0] 

Q5: How many characters can I input in the text entry box of Ulead COOL 3D? 

Answer: You may enter up to 32 characters (including spaces) using any of the standard 

characters in the selected font's character set, including special symbols such as the "space 

key". 

 
Q6: How can I remove the background of the title I have created in Ulead COOL 3D so that it 

will blend in seamlessly with the background of my web page? 

Answer: You have to save the title as GIF or Animated GIF. In the Image:Save As:GIF File/GIF 

Animation File dialog box, Select the "transparent background" check box to enable 

transparency. This will make the background transparent when you place the file into web 

browsers or another application that supports the transparency feature. 

 
Q7: When adding a custom color, camera angle, animation, texture, background or style in the 

EasyPalette, it does not appear the next time I run Ulead COOL 3D. 

Answer: Use the Windows Explorer to go to the Ulead COOL 3D \Presets\ directory. Go to 

Edit:Select All or just press Ctrl-A to select all .UTX files. Then go to File:Properties or right click 

to select Properties, then clear the "Read Only" check box under the Attributes section. 



 

Q8: Why does Ulead COOL 3D change the font type when applying the presets under the 

EasyPalette:Gallery? 

Answer: This is because the presets under the Gallery pane are completed samples, 

combining style, color and lighting, texture, and font attributes to apply to a title. If you only want 

to change specific attributes, expand the "More" File directory in the Easy Palette window. 

 
Q9: Can I create alpha channel images in Ulead COOL 3D? 

Answer: To create an image with an alpha channel, click File:Create Image Files- TGA File and 

assign a name and destination for your file in the resulting dialog box. If you wish to keep the 

title as an Alpha channel (useful for transparency and overlay editing), select "Transparent 

background." 
 

[COOL 3D 2.0] 

Q10: Can I import image files into Ulead COOL 3D 2.0 and create 3D titles out of it? 

Answer: Yes, you can import WMF and EMF 2D graphics files in Ulead COOL 3D and adjust 

the extrusion to create 3D titles. If you are importing WMF files, it should include vector data. 

Thus, WMF files that are created in raster-based software such as PhotoImpact, cannot be 

used with Ulead COOL 3D. Additionally, only closed path WMF and EMF files are supported. 

 

Q11: Can I insert a Cool 3D 2.0 object within FrontPage 98 Editor? 

Answer: Yes, you can insert Ulead COOL 3D objects within FrontPage Editor through the 

"Insert Ulead COOL 3D File" under the Insert menu. Make sure that you have installed 

FrontPage before installing Ulead COOL 3D. 

1. Start FrontPage Editor, then click Insert: Insert Ulead COOL 3D File. This launches 

Ulead COOL 3D program automatically.  

2. Create a 3D title in Ulead COOL 3D.  

3. In COOL 3D, click File: Send to Front Page command, then select a file format from sub 

manual, after saving, the image will insert to FrontPage Editor.  

For FrontPage Express, which is installed with Windows 98, there is no way to insert a Ulead 

COOL 3D object from within that program. As a workaround, save the Ulead COOL 3D object 

as a GIF, JPEG or animated GIF and use the Insert/Image command. 

 
Q12: How can I use the presets from Ulead COOL 3D 1.0 with Ulead COOL 3D 2.0? 

Answer: Follow the steps to import the COOL 1.0 presets to COOL 3D 2.0: 

1. Click the right mouse button on any thumbnail in the EasyPalette, and select "Import..." 

command.  

2. In "Import thumbnails" dialog box, look for \COOL 3D 1.0\Presets folder, select the .upf 



files you want and click "Open".  

 

Q13: How can I change the resolution of a Ulead COOL 3D image? 

Answer: To change the resolution of a Ulead COOL 3D image, first create the title as an image 

file, by clicking File:Create Image Files and select the file format to use (TGA or BMP is best). 

Then open the file in an image editing program that allows you to change resolution. Remember 

that changing the resolution affects the image's dimensions when printed. If you intend to 

increase the resolution, (for example, from 96 dpi to 300 dpi), then the original saved title should 

be about three times bigger than the final desired dimensions. 

 

Q14: How can I remove the background of the title I have created in Ulead COOL 3D so that it 

will blend in seamlessly with the background of my web page? 

Answer: Save the title as a GIF or Animated GIF. In the File:Create Image/Video Files:GIF 

File/GIF Animation File dialog box, select the "Transparent Background" check box to enable 

transparency. This will make the background transparent when you place the file into web 

browsers or another application that supports transparency feature. 

 

Q15: How can I create alpha channel images in Ulead COOL 3D? 

Answer: To create an image with alpha channel, click File:Create Image Files- TGA File and 

assign a name and destination for your file in the resulting dialog box. If you wish to keep the 

title as an Alpha channel (useful for transparency and overlay editing), select "Transparent 

background." 

 
Q16: What is a closed path? 

Answer: A closed path "closes back on itself", meaning that if you pick any point on path and 

start tracing the path, you'll come back to your starting point. 

 
[COOL 3D 2.5] 

Q17: How do I create a box and apply different textures on it? 

Answer:  
1. Insert text  

2. Click Object Effects, select Box and click FX on the Attribute toolbar to apply a box 

effect. (If you don't see your Attribute toolbar, select View: Attribute Toolbar.)  

3. On the Attribute toolbar, change Texture Type to "Round".  

4. On the Standard Toolbar, click the Select Face button to select which faces you want to 

apply textures to. You only can apply five different textures (images) to the box; the top 

and bottom will use the same texture. For more details, please take a look at this 



example. Illustration 

5. To apply a texture, drag and drop a preset from the EasyPalette or click "Use Image" 

and select a previously saved BMP or JPG file from the Open dialog box.  

 

Q18: How do I use presets from Ulead COOL 3D 1.0 in version 2.5? 

Answer: Follow these steps to import COOL 1.0 presets into COOL 3D 2.5: 

1. In COOL 3D 2.5, right click on any thumbnail in the EasyPalette, and select "Import..." 

command.  

2. In the "Import thumbnails" dialog box, look for the \COOL 3D 1.0\Presets folder, select 

the .upf files you want and click "Open".  

Q19: How do I use presets from Ulead COOL 3D 2.0 in version 2.5? 

Answer: Before installing COOL 3D 2.5, please export presets that you like in COOL 3D 2.0 to 

a .uez file first. You may follow the steps to export COOL 2.0 presets and import to COOL 3D 

2.5: 

1. In COOL 3D 2.0, select thumbnails you like in the EasyPalette, and select "Export..." 

command.  

2. In "Export thumbnails" dialog box, select a folder, name the files and save them. 

3. In COOL 3D 2.5, click the right mouse button on any thumbnail in the EasyPalette, and 

select "Import..." command.  

4. In "Import thumbnails" dialog box, select the files you want (*.uez) and click "Open".  

Q20: Why can't I use HAL rendering function? 

Answer: The HAL rendering function works only when your display card supports Direct 3D. 

Furthermore, some display cards only support Direct 3D in Full Screen mode (like some 

games), High Color (16 bit) or True Color (32 bit) modes. To use this function, you have to 

update your DirectX driver to version 6.1 or above. 

 

Q21: Why does display speed become slower after I apply some plug-in effects? 

Answer: The animation in a COOL 3D project requires real time rendering, therefore when a lot 

of plug-in effects are applied to the objects, it slows down the display rendering speed. One way 

to obtain a faster result is to reduce the size of the display window by changing the percentage 

in the Proportion View drop-down list. 
 
Q22: I have downloaded a True Type font, but it is not available in the fonts list. How do I get 

Cool3d to use this downloaded font?  

Answer:  

ftp://ftp.ulead.com/Silent/C3d25box.jpg


To add a new font to your computer  

1. Click Start, point to Settings, click Control Panel, and then double-click Fonts.  

2. On the File menu, click Install New Font.  

3. Click the drive, and then click the folder that contains the fonts you want to add.  

4. Click the font you want to add.  

Notes:  

∙ To select more than one font to add, hold down the CTRL key, and then click each of the 

fonts you want.  

∙ For TrueType, Raster, or Adobe Type 1 fonts, you can also add the font by dragging the 

appropriate files to the Fonts folder. If you want to see the file extensions in Windows Explorer, 

click View, click Options, and then click the View tab. Click to clear the Hide file extensions for 

known file types in the check box. This works only for fonts that are not in the Fonts folder.  

∙ To add fonts from a network drive without using disk space on your computer, make sure 

that the Copy fonts to Fonts folder check box in the Add Fonts dialog box is clear. This option is 

available only when you install TrueType or Raster fonts from the Install New Font command.  

In addition, COOL 3D only supports True Type Font.   
 
Q23: When I add bevels to the words, the color of the words and the bevels are about the same. 

I want to make the color of words different from the bevels, what steps should I take?  

Answer: On the Standard Toolbar you may click the select face button to select which face that 

you want to apply the different texture.  

**Select Front Face:(this is the front text face)  

Applies the attributes of a selected thumbnail only to the front face of your title.  

**Select Front Bevel Face:(this is the front text bevel)  

Applies the attributes of a selected thumbnail only to the front face of your title bevel.  

**Select Side Face:(this is the board)  

Applies the attributes of a selected thumbnail only to the sides of your title.  

**Select Back Bevel Face:(this is the back text bevel)  

Applies the attributes of a selected thumbnail only to the back face of your title bevel.  

**Select Back Face: (this is the back text face)  

Applies the attributes of a selected thumbnail only to the back face of your title.   

 
Q24: When I apply the some titles, why do some strange or imperfect dots appear around the 

text object?  

Answer: This is not a bug for COOL 3D. This problem is related to some type of Fonts that are 

not updated with the standard rules. So when you apply our gallery to such fonts, it might cause 

the letter with such imperfections.   

 



Q25: How do I create an image file in COOL 3D 2.x?  

Answer: The File:Save/Save As command saves the active Ulead COOL 3D 2.0 title for future 

editing. To save the title as an image file based upon the current Ulead COOL 3D title's 

appearance and Image:Output Quality setting, click File/Create Image Files. A submenu will 

open with the following file format options: BMP, GIF, JPEG, and TGA. To save the title as an 

animated GIF or video file, click File/Create Video Files.   

 
Q26: How do I insert an image into FrontPage?  

Answer: To use a Ulead COOL 3D object in FrontPage, you need to save the 3D title as an 

image file in Ulead COOL 3D, and then insert it into FrontPage by clicking Insert\Picture: From 

File.  

To learn how to create an image file, please refer to Q25. 

 
Q27: I have created a number of animated GIFs to use in PowerPoint 2000. I want the 

animated GIFs to play just once, but it seems to fail to complete the work. Is there a way to let 

me achieve that? 

Answer: Once you insert the .gif file into PowerPoint, then the loop times of the .gif file are 

controlled by PowerPoint and not COOL 3D. And as we know, there is no such function for 

setting loop times in PowerPoint.   

 
Q28: On creation of a new file I cannot save the file as a *.gif as the file selection is "grayed" out. 

This is v2.5 and is a "SE" version and came bundled with the graphics card. How do I enable the 

Gif file creation? Or is this action disabled? *.bmp files and jpeg files are ok.  

Answer: We didn't support GIF file format in SE version, we suggest that you purchase the 

Upgrade version to upgrade from SE version to FULL version.  

Please get relevant info from link below:  

http://www.ulead.com/cool3d/upgrade.htm 

 
Q29: How do I get a jpeg or a gif image into this program in order to use it? I have tried converting, but 

Cool 3d will not recognize it. I have tried copy/paste, but it crashes my system. I have images I want to 

work with in Cool 3d.  

Answer: You can import WMF and EMF 2D graphics files in Ulead COOL 3D and adjust the 

extrusion to create 3D titles.  

If you are importing WMF files, it should include a vector data. Thus, WMF files that are created 

in raster-based software such as PhotoImpact, Paint Shop Pro cannot be used with Ulead 

COOL 3D  

The most popular software to create that kind of wmf or emf is Corel Draw and Adobe Illustrator.  

Additionally, only closed path WMF and EMF files are supported.  

http://www.ulead.com/cool3d/upgrade.htm


Closed path means it "closes back on itself", so that if you trace it out, starting from anywhere 

and keeping on going, you'll come back to your starting point.  

 
Q30: How do I get an explosion to disappear at the end of the animation? All I end up with is a 

full frame of particles. I want the particles to fall down totally off the screen.  

Answer: In some explosion presets, they can't be completely taken out of the scene leaving 

only the background after the explosion.   

Our suggestions are as follows:  

1.Select the preset that can do what you want.  

2.In the latest key frame, drag the fragments out of the window.  

3.Select a preset and set the Movement Type to Descend or Ascend.   
 

Other FAQs 
Q1: My CD is broken and I can't install the program, what should I do? 

Answer: If your Ulead software CD was lost or damaged and it was included with other software on a 

single CD delivered by a third-party hardware device or software manufacturer (OEM), you will first 

need to check with the OEM to see if they can provide the proper replacement media. This is because, in 

addition to the Ulead product you received, your CD probably included other software that you needed. 

If the device manufacturer cannot supply a replacement CD, you may send a written request to the Ulead 

Customer Service Department for a replacement. If we are able to replace the software, there will be a 

small replacement fee of $15.00, plus $5.00 for shipping and handling. If the CD was missing from the 

original bundle, only the OEM can assist you. 

Send your replacement request with the following information: 

Name 

Company Name 

Address 

City, State, ZIP 

Phone 

Email address 

Serial number 

Name and version number of the Ulead software that is being requested 

If the product was bundled with a hardware device, the name of the manufacturer and model name. If the 

replacement is for damaged media, include a photocopy of either the bad disk or the user manual for the 

requested Ulead product. In case of lost media, another proof of ownership can be accepted. Normally, a 

photocopy of the box, manual, or sales receipt is adequate. 

You should receive the replacement media within 2-3 weeks. Replacement media is available only for 

US and Canadian customers. 

Fax to 310-523-9399 or call 310-523-9393 ext. 134 if you have any questions. 



 
Q2: My hard drive was damaged and the COOL 3D program I bought online was damaged along with 

the hard drive, where can I download the program again? 

Answer: WebUtilities does not process direct customer transactions, so what you need to do is go back 

to the online store where you first made your purchase. We don't have the entire customer information 

database as some online stores don't pass this information on to us. When you made your purchase, you 

should have been asked to choose from a list of our online partner stores. This store should have sent you 

a confirmation e-mail once they processed your credit card. There should also be a mention of the store 

on your credit card receipt. Here is a complete list of our online partners: 

WebUtilities Online Store  

beyond.com  

BuyDirect.com  

Soft Gallery  

buyOnet  

Software.net (beyond.com) 

 
Each online store has a slightly different policy, but once you explain to them your situation, they should 

be able to provide you with a new copy (usually they will give you an FTP address from which to 

download a new copy). 

Or you can e-mail support2@webutilities.com for technical support. 

 
Q3: I don't have a manual. Can I still get one? 

Answer: The company you bought the software from did not purchase the manual from us to be included 

with the program. However, there is an online version which can be read in Acrobat Reader. You can also 

find the PDF file in the Manuals or Documents folder in the CD. Double-click on READER.EXE in the 

same directory to install Acrobat Reader if necessary. You can access the extensive online help anytime 

by pressing [F1]. If you are interested in upgrading, please contact the Ulead Upgrade Center near you. 

Upgrade products will have manuals. 
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